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Chapter 1:	 What’s new in 3.0 ?







1.1	 Introduction 

Thank you for purchasing the all-new AURO-3D® Creative Tools Suite v3.0.


This document will guide you through new features and show you how to make use of them.


For more information on the existing features, please refer to the manual of the previous releases 
(provided with this version as well). 


→ Link to AURO-3D® Authoring Tools Documentation

→ Link to AURO-MATIC® PRO Documentation

1.2	 New Features 

• Dynamic objects for Immersive mix. → Chapter 3.6

• Support for Loudness Measurement that ensures the immersive mix, derived down-mixes and 
interactive programs comply to the EBU R128 guidelines. → Chapter 3.5

• New Monitoring functions providing a unique ability to switch between different versions of the mix, 
all on the same monitoring setup. → Chapter 3.4

• Mix Profiles that ensure the compatibility of the mix with supported features and limitations of the 
target deliverable. → Chapter 3.3.1

• Multiple Programs/Presentations, with support for multiple languages, auxiliary tracks, commentary 
tracks and much more in a single audio stream. → Chapter 3.7

• Interactive Dialog Enhancement through Interactive Gains. → Chapter 3.7.2.3

• Auro's all new and patent-pending rendering algorithms with room-centric panning, ensuring that all 
mixes are translated as intended, from playback in studio, to cinema theaters, home systems and 
mobile devices.


• Ability to export ADM BWF-files with support for the Emission Profile, according to ITU-R Rec. 
BS.2076. → Chapter 3.8.1.2

• Ability to export IAB files with AuroMax for Digital Cinema using SMPTE IAB (ST 2098-2).  
→ Chapter 3.8.1.3 

• Quality Control feature with Import and Playback of SMPTE IAB and ADM files. → Chapter 3.8.3

• New output options in Auro-Return plugin (Monitoring, Bed Mix and Objects Channel Mix).  
→ Chapter 3.9

• AuroMax Speaker Positions file to set custom speaker positioning. → Chapter 3.1
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Figure 1 - 1 | Creative Tools Suite Product
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1.3	 CTS Concept 

 
 

The AURO-3D® Creative Tool Suite 
version 3.0 is a complete set of plugins to 
create and author immersive and 
interactive content in the AURO-3D® 
formats  in parallel to legacy format mixes 
(Mono/Stereo/Surround). Each plug-in in 
the suite provides a distinct functionality 
and is designed to optimally integrate into 
any existing content-creation workflow for 
movies, music and broadcast applications. 


The Auro-Panner plugins let users mix  
audio content in 3D. The vector-based 
panning information is then rendered in 
the A3DHost processor outside the DAW. 
Each inserted Auro-Panner sends its 
individual audio stream and related 
vector-based panning information, through 
the Auro-Bus plugin to the Auro-Mixing 
Engine.  
 
The Auro-Mixing Engine plugin lies at 
the heart of the AURO-3D® workflow. It 
receives audio from the connected Auro-
Bus plugins, sets the audio format and 
outputs mixes, down-mixes and encoded 
streams to the Auro-Return plug-ins. By 
selecting the right Mix Profile, it is now 
possible to verify the compatibility of 
mixes with the supported features and 
limitations of the target deliverable. The 
new Monitoring functions also bring the 
unique ability to switch between different 
versions of the mix directly from the Auro-
Mixing Engine. 
 
The Auro-Return plugins bring processed 
audio back to the DAW and eventually 
output the desired mix format to chosen 
audio devices.


An AURO-3D® configurat ion (e.g. 
immersive 13.1 in Figure 1 - 2) uses 
typically two Auro-Return plug-ins inserted 
on separate DAW tracks to split the Auro-
Mixing Engine output into a Lower (blue 
circle) and a Height + Top channel-layer 
(yellow and red circles). Multiple masters 
of the same mix can be created in the 
uncompressed audio domain. Next to the 
traditional channel-based versions, 
the Creative Tools Suite version 3.0 now 
supports the creation of object-based 
immersive and interactive mixes. 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Figure 1 - 2 | Creative Tools Suite Concept 





 

 
1.4	 Account & Licenses 

The Creative Tools Suite version 3.0 introduces a brand new licensing scheme.


All functionality to create and monitor an immersive mix in the AURO-3D® formats for any target 
application is now available for free (Auro-Matic 2D included). It is now possible to create personal 
accounts and download the installer from the new web-shop. 


This free license allows users to monitor their mixes without restrictions and export uncompressed 
versions of the stems.


1.4.1	 Individual Licenses 
 
When it comes to exporting the mix in a specific format, various options are available through the new 
rent-to-own model. This new model requires to finance a small fee (depending on the selected export(s)) 
every quarter of the year. After for four years, the license becomes perpetual (at no additional cost). 
Users can cancel the subscription anytime. Each license can now be activated on 3 different machines, 
not only using the iLok, but also linked to your computer.

 
The following features require a license:  

• Auro-Matic® 3D up-mixing.


• Auro-Codec® Encoding and Decoding.


• AuroMax® for Digital Cinema export (SMPTE ST 2098-2).


• AURO-3D® ADM BWF export.


1.4.2	 Collections 

In many occasions, a combination of multiple licenses will be needed in certain typical content creation 
workflows. The following Subscription Collections provide you with all the relevant tools for a reduced 
price as a Subscription with a monthly payment plan. In these subscription plans, new features and tools 
can be added over time, making sure you always have the latest and greatest tools available. Note that 
activation using iLok Cloud is not enabled for theses Collections.

1.4.3	 Upgrades  

For existing users, attractive upgrades are available.  
Please go to the webshop and create your account. The system will check for existing valid licenses on 
your iLok account and apply the discount automatically.


Bundle Auro-Codec AuroMax ADM Export Auro-Matic Pro 3D

AURO-3D® CTS for Music ✓ ✓

AURO-3D® CTS for Cinema ✓ ✓ ✓

AURO-3D® CTS for Movies ✓ ✓ ✓ ✓

AURO-3D® CTS for Broadcast ✓ ✓ ✓
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Chapter 2:	 Starting up with 3.0 
 
This chapter provides instructions to properly install the AURO-3D® Creative Tools Suite v3.0, steps to 
follow in order to set up a basic AURO-3D® mixing session in Pro Tools and additional routing 
approaches for each Creative Tools.

2.1	 Requirements 

CTS version 3.0 is available as AAX plugin for Pro Tools 11 and higher, running on macOS 10.9 up to 
10.15. 

2.2	 Installation 

1. Uninstall any previous installation of the AURO-3D® Authoring Tools or AURO-3D® Creative Tools Suite 
by using the AURO-3D® Uninstall application.  
 
2. Double-click the ZIP file downloaded from the Auro Technologies website, then double-click AURO-3D® 
Creative Tools Suite.pkg to begin the standard installation.  
 
3. Follow the installation instructions in the install wizard and allow the installer to control “System Events” 
by pressing the “OK” button on the corresponding window.


2.3	 Setting up Metadata Languages  
 

What are these Metadata Languages Used for? 
 
The AURO-3D Creative Tools Suite v3 allows to select languages that can be later assigned to 
Objects and Groups in the project. These selected languages will also become available in the 
Program Labels Table, letting users name Interactive Programs in different languages. Another 
typical application of these Metadata Languages is the configuration of Switch Groups in order to 
create multiple languages selection within one or more Interactive Programs. After selecting the 
desired languages and configuring them in the project, all related information then will be 
exported in the metadata of files that support Objects (AuroMax Export option) or files that 
support both Objects and interactive content such as Programs (ADM-File Export option). 




Links to More Detailed Information
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Objects → Chapter 3.6 
Object Language Drop Down Menu → Chapter 3.6.3.2
Groups → Chapter 3.7.1.4  
Group Language Drop Down Menu→ Chapter 3.7.3.2 
Switch Group Button→ Chapter 3.7.3.6

Programs → Chapter 3.7 
Program Labels Table → Chapter 3.7.4

AuroMax Export → Chapter 3.8.1.3 
ADM-File Export → Chapter 3.8.1.2

Figure 2 - 1 | All Applications of Metadata Languages 
                      in the Creative Tools Suite Plugins  

Auro-Panner Plugin Auro-Bus Plugin Auro-Mixing Engine Plugin

Voice Over Panner

 

Language Assignment for Object Language Assignment for Group Program Labels Confi

Language Selection in Switch Groups





 

Step Guide to Select Desired Metadata Languages



1. Open the Auro Language Selector application via the Auro-Settings Menu Bar Application.


2. Select desired languages to be applied.  


A.   Available Languages Menu: Lets users select one language to be added. 
 
B.   Selected Languages Menu: Displays the current selected languages in the Auro system. 
 
C.   Add Button: Adds the selected language from the Available Languages Menu (A) into the Selected 	

   Languages Menu (B). 
 
D.   Remove Button: Removes the selected language in the Selected Languages Menu (B). 
 
E.   Arrow Buttons: Moves the position of the selected language in the Selected Languages Menu (B). 
 
F.    Cancel Button: Resets the selected languages to default. 
 
G.   Apply Button: Applies the selected languages in the Auro system after modification.

The maximum number of selected languages is limited to four. The default languages are 
English, French and German. The User’s selection can be preserved after uninstalling the 
Creative Tools Suite by unchecking the User Preferences checkbox in the Uninstall Application 
(the Auro-Uninstall Application is accessible from the Auro-Settings Menu Bar Application).
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Figure 2 - 2 | Languages Selector Link in Auro-Settings Menu Bar Application

Figure 2 - 3 | AURO Languages Selector Standalone Application Overview
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2.4	 Setting up Hardware  

1. Go to the Menu Bar Application Auro-Settings > Hardware and select the type of hardware used with 
the DAW.


Native: Select this option if you are using a Pro Tools Native or HD Native system. 

 
HDX High Latency: Select this setting if you are using an HDX System with a H/W buffer size of 1024 
samples. When working in 96 kHz, HDX High Latency is not supported: Use HDX Low Latency instead.

  
HDX Low Latency: Select this setting if you are using an HDX system with a H/W buffer-size lower than 
1024 samples. Only H/W buffer sizes of 256, 512 or 1024 samples are supported when working with the 
AURO-3D® Authoring Tools.





2. Select one speaker configuration in the Auro-Settings menu bar application. The selected speaker 
configuration must correspond to the main audio system used. 




 
3. From the Output tab of the I/O Setup window in Pro Tools (Pro Tools > Setup > I/O…), create output 
paths for all audio systems in used. For Immersive configurations, at least two paths must be created to 
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Figure 2 - 4 | Hardware Selection in Auro-Settings Menu Bar Application

Figure 2 - 5 | Speaker Confi





 

split the outputs into a Lower and a Height (+ Top) channel-layer(s). In the Bus tab, virtual buses sharing 
the same formats must be mapped to the output paths (sub-paths must be automatically created as 
well). It is recommended to use identical names. 

 
Examples of paths for different speaker configurations:


• Stereo: Create one stereo path.


• Surround 5.1: Create one 5.1 path.


• Surround 7.1: Create one 7.1 path.


• Immersive 9.1: Create one 5.1 path formats for the lower layer and one Quad path for the 
height layer.


• Immersive 11.1: Create one 5.1 path formats for the lower layer and one 5.1 path for the 
height layer.


• Immersive 13.1: Configuration: Use one 7.1 path for the lower layer and one 5.1 path for the 
height + top layers.


• AuroMax: Setup guides available in the last chapter. → Chapter 3.10

The Auro-Return plugins provide presets for channels’ distribution. It is also possible to manually 
route any audio sources to any specific channels. Therefore, the Auro-returns plugins also 
operate as an I/O matrix. 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 A  7.1 path to output audio in the lower layer of an immersive 13.1 configuration.

 B  5.1 path to output audio in the height and top layers of an immersive 13.1 configuration.

 C  Additional stereo path (e.g. monitoring stereo down-mix with a different audio system).

 D  Additional 5.1 path (e.g. monitoring encoded stream through an AV Receiver).

 A 
 B 

 C 
 D 

Figure 2 - 6 | Example of I/O Setup in Pro Tools for 13.1 Configuration and Additional Systems





 

2.5	 Setting up a New Session 

1. From the Bus tab of the I/O Setup window in Pro Tools (Pro Tools > Setup > I/O…), create two 7.1 
virtual buses: one named “Dummy”, the other one named “Fader Link” (Auto-create sub path option must 
be selected).  
 
 
 

2. In the Edit window of Pro Tools (Pro Tools > Window > Edit…), create one 7.1 Aux Track named “Mix 
Engine” (Shift + Cmd + N). The input module of this track must be assigned to the “Fader Link” virtual 
bus. The output module of this track must be assigned to the “Dummy” virtual bus. Insert Auro-Mixing 
Engine plugin in the track.

 

 
If using HD or HDX Audio Systems, a DSP plug-in must be inserted and activated on the first 
Insert slot of every track that contains an AURO-3D® plug-in.

Inserting a (multi)-mono DSP version of the Trim plug-in reduces the DSP-overhead to a 
minimum and leaves the audio unaffected if the initial settings remain unchanged. 

3. Open the Auro-Mixing Engine plugin and select one desired Mix profile in the Settings tab. Select one 
bed configuration as well.
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Only required if using HD or HDX Audio Systems 

Figure 2 - 7 | Virtual Buses in I/O Setup

Figure 2 - 9 | Auro-Mixing Engine Settings Tab

Figure 2 - 8 | Auro-Mixing Engine Track in Pro Tools





 

 
4. Still in the Edit window of Pro Tools (Pro Tools > Window > Edit…), create Aux Tracks (Shift + Cmd + 
N) sharing the same formats than the output paths created in the I/O setup earlier in order to insert the 
Auro-Return plugins. For example, the 13.1 configuration requires two Aux Tracks named “Return Lower” 
and “Return Height&Top”. The input modules of these track must be assigned to “no input”. The output 
modules of these tracks must be assigned to the corresponding output paths.


Additional Return Tracks can be created for additional audio systems. (e.g. one extra stereo Aux Track 
for extra stereo audio system, one extra 5.1 Aux Track for extra AV Receiver output, etc.).


5. Open the Auro-Return plugins, name them “Return Lower” and “Return Height & Top” (or simply 
“Return Height” if there is no Top channel in the current speaker configuration) using the Name fields. 
Select “Mix” in the Source Drop Down Menus and select adequate presets in the Preset Drop Down 
Menus.


 

6. In the Edit window of Pro Tools (Pro Tools > Window > Edit…), create one mono Audio Track named 
“Panner Test” (Shift + Cmd + N). The input module of this track must be assigned to “no input”. The 
output module of this track must be assigned to the “Fader Link” virtual bus. Insert Auro-Panner plugin in 
the track. For better routing visualisation, drag and drop the Panner Test Track to position it at the top of 
the Edit window. 

Any other audio plugins must be inserted before the Auro-Panner plugin. If using HD or HDX 
Audio Systems, Any other audio plugins must be inserted after the DSP Trim plugin (cf. Audio 
Track Approach → Chapter 2.5.1.3).
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Only required if using HD or HDX Audio Systems 

Figure 2 - 10 | Auro-Return Tracks in Pro Tools for 13.1 Configuration

Figure 2 - 11 | Auro-Return Plugins for 13.1 Configuration

Only required if using HD or HDX Audio Systems 

Figure 2 - 12 | Auro-Panner Test Track in Pro Tools





 

7. In the Edit window of Pro Tools, make a selection of few seconds on the timeline and print a sine wave 
signal of 1000 Hz using the keyboard shortcut “Shift + Ctrl + Option + 3”. 


Instead of printing the signal, a “Signal Generator” (Avid native plugin) can also be inserted 
before the Auro-Panner. If opting for that solution, playback must be started in order to listen to 
the generated signal. 


8. Start playback and manipulate the controls in the Auro-Panner plug-in. Panned audio can now be 
monitored through the selected speaker configuration.   

 

 
2.6	 Pro Tools Routing Overview 

Following the basic setup guide, this next chapter describes how to configure relevant Pro Tools tracks 
and proposes different routing approaches when it comes to using the AURO-3D® Creative Tools Suite. 
Each sub-chapter outlines recommended configurations for each track wherein one or several dedicated 
AURO-3D® plugins are inserted. 


This section does not cover the detailed functioning of the AURO-3D® plugins themselves, but rather 
illustrates the possible ways of operating and connecting them inside the DAW environment. For more 
detailed information about the standard features of the AURO-3D® plugins, please refer to the manual of 
the previous releases (provided with this version as well). →  Link to AURO-3D® Authoring Tools 
Documentation, → Link to AURO-MATIC® PRO Documentation.


The following figure (Figure 2 - 15) corresponds to a practical pattern in order to rapidly examine 
workable configurations of tracks containing specific AURO-3D® plugins. The figure on its own visually 
provides information about dedicated track’s type, track's format, input module, output module and 
insertion’s order for the different AURO-3D® plugins. More detailed explanations about track's 
configuration and examples of routing approaches can be consulted in the corresponding sub-chapters. 
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Make Selection

Print Signal (Shift + Ctrl + Option + 3)

↓

↓

Figure 2 - 13 | Printed Signal in Edit Window

Figure 2 - 14 | Basic Setup Overview of AURO-3D® Creative Tools Suite in Pro Tools

file:///Library/Application%20Support/Auro%20Technologies/Documentation/Auro-3D_Authoring_Tools_Documentation.pdf
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Figure 2 - 15 | Pro Tools Routing Pattern for AURO-3D® Creative Tools Suite
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2.6.1	 Auro-Panner Tracks 

Purpose of the Plugin


The Auro-Panner plugins let users mix audio content in 3D. They send their track’s audio to a selected 
Auro-Bus, which routes it to the Auro-Mixing Engine. 


For more detailed information about the functioning of the Auro-Panner plugin, please refer to chapter 8.1 
of the AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).

Pro Tools Routing

Auro-Panner plugins can be inserted on Audio Tracks or Aux Tracks (recommended) using any formats 
from “mono” to “7.1”. If using HD or HDX Audio Systems, a DSP plug-in must be inserted and activated 
on the first Insert slot of the track before inserting the Auro-Panner plugin. A simple mono or multi-mono 
DSP Trim plugin (Avid native) set as default is recommended. An Auro-Panner is assigned to the Auro 
Main Bus by default. However, it is possible to assign the Auro-Panner to an existing Auro-Bus in the 
drop down menu situated under the Solo button in the Auro-Panner plugin window.  
 
The output module of any Auro-Panner tracks must be assigned to the “Fader Link” virtual bus in order to 
benefit from the optional Fader Link feature that allows the Pro Tools fader, solo and mute buttons to 
control the Auro Panner's fader, solo and mute buttons. Using Fader Link, X/Y panning can also be linked 
to the Pro Tools X/Y panning controls. Fader Link can be activated from the Auro-Settings menu bar 
application. The “Fader Link” virtual bus does not carry any audio. For more detailed information about 
Fader Link, please refer to chapter 3 of the AURO-3D® Authoring Tools - User Guide (→ Link to 
AURO-3D® Authoring Tools Documentation).


There are different ways to route audio sources to the Auro-Panner Tracks. The three following sub-
chapters provide three examples of routing approaches:


2.6.1.1	 Sub Group Track Approach

The Sub Group Track Approach is recommended. 


Using this approach, mixers can operate the regular Pro Tools workflow until the need of mixing in 3D 
using dedicated Auro-Panner tracks. This way of doing is particularly convenient when using devices 
such as DAW control surfaces or digital mixing consoles (e.g. Icon D-Control). 


In this approach, any other audio plugins are not inserted directly on the Auro-Panner Track itself but 
rather inserted on the audio tracks that are routed to it.


The following figure (Figure 2 - 16) illustrates the Sub Group Track Approach. In this example, Drums 
Audio Tracks are grouped into an Aux Track (Σ | Sub Track) that is routed to another Aux Track (⌖ | Auro 
Panner) wherein the Auro-Panner plugin is inserted using relevant virtual buses. Parallel treatments (e.g. 
parallel reverb, parallel compression) are also routed and summed into the Auro-Panner track.
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Alternatively, any drums Audio Tracks or parallel treatments can also be separated from the group to 
benefit from individual 3D panning. 


The following figure (Figure 2 - 17) illustrates an example of this routing alternative (e.g. separated 
reverb) using a second Auro-Panner plugin and one additional virtual bus:
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Figure 2 - 16 | Sub Track Group Approach with Auro-Panner Plugins

Audio Sent  
to Auro-Mixing Engine.

Data Used for Optional 
Fader Link Feature.

List of all Tracks Drums Tracks





 

2.6.1.2	 Sub Track Approach

The Sub Track Approach is also recommended. 


In this approach as well, mixers can operate the regular Pro Tools workflow until the need of mixing in 3D 
using dedicated Auro-Panner tracks. This way of doing is also convenient when using devices such as 
DAW control surfaces or digital mixing consoles (e.g. Icon D-Control). In this approach as well, any other 
audio plugins are not inserted directly on the Auro-Panner Track itself but rather inserted on the audio 
tracks that are routed to it.


Unlike the Sub Track Group Approach, the Sub Track Approach offers more control for panning each 
audio element individually in the 3D environment. 


The following figure (Figure 2 - 18) illustrates the Sub Track Approach. In this example, each Audio Track 
(♪ | Audio Source) is routed to one respective Aux Track (⌖ | Auro Panner) wherein a dedicated Auro-
Panner plugin is inserted using relevant virtual buses: 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Figure 2 - 17 | Alternative Sub Track Group Approach with Auro-Panner Plugins
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Figure 2 - 18 | Sub Track Approach with Auro-Panner Plugins
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2.6.1.3	 Audio Track Approach

The Audio Track Approach consists on inserting the Auro-Panner plugin directly on an Audio Track.

If additional audio plugins are inserted between the 
optional DSP Trim plugin and the Auro-Panner 
plugin, this approach requires to constantly activate 
Fader Link in order to properly operate the delay 
compensation of all tracks (required data sent 
through the Fader Link virtual bus).

For more detailed information about Fader Link, 
please refer to chapter 3 of the AURO-3D® 
Authoring Tools - User Guide (→ Link to 
AURO-3D® Authoring Tools Documentation).

The following figure (Figure 2 - 19) illustrates the Audio Track Approach. In this example, Auro-Panner 
plugins are directly inserted on Audio Tracks. Additional audio plugins are inserted between the DSP Trim 
plugin and the Auro-Panner plugin. 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Figure 2 - 19 | Audio Track Approach with Auro-Panner Plugins

Figure 2 - 18 | Fader Link in the Auro-Settings Menu Bar Application
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2.6.2	 Auro-Matic Pro Tracks 

Purpose of the Plugin


Auro-Matic Pro 3D can function as a stand-alone plug-in (without an Auro-Mixing Engine) that upmixes 
mono, stereo, 5.1 surround, and 7.1 surround sound sources to a three-dimensional  
sound field. If the AURO-3D® Creative Tools are installed, Auro-Matic Pro 3D can also be connected to 
the Auro-Mixing Engine to use the upmixed sound source directly in an AURO-3D® mix. 


Auro-Matic Pro 2D can function as a stand-alone plug-in that upmixes mono and stereo sound sources to 
a 5.1 surround sound field. If the AURO-3D® Creative Tools are installed, Auro-Matic Pro 2D can also 
connect to the Auro-Mixing Engine to use the upmixed sound source directly in an Auro- 3D mix. 


For more detailed information about the functioning of the Auro-Matic Pro 2D/3D plugins, please refer to 
the Auro-Matic Pro 2D/3D - User Guide (→ Link to AURO-MATIC® PRO Documentation).

Pro Tools Routing

Auro-Matic Pro 2D/3D plugins can be inserted on Audio Tracks or Aux Tracks (recommended) using any 
formats from “mono” to “7.1” (c.f. routing approaches in previous chapter). As illustrated in Figure 2 - 20, 
the format of the track is modified according to the selected up-mix version of Auro-Matic Pro plugins. 


Just like the Auro-Panner plugin, an Auro-Matic Pro plugin is assigned to the Auro Main Bus by default. 
However, it is possible to assign the Auro-Matic Pro plugin to an existing Auro-Bus in the drop down 
menu situated under the Solo button in the Auro-Panner plugin window. 

 
The output module of any Auro-Panner tracks must be assigned to the “Fader Link” virtual bus. If using 
HD or HDX Audio Systems, a DSP plug-in must be inserted and activated on the first Insert slot of the 
track before inserting the Auro-Panner plugin. A simple mono or multi-mono DSP Trim plugin (Avid native) 
set as default is recommended.


2.6.3	 Auro-Decoder Tracks 

Purpose of the Plugin

The Auro-Decoder plug-in is designed to decode AURO-3D® encoded content. It is a real-time processing 
plug-in that connects to Auro-Return plug-ins, either directly or via an Auro-Mixing Engine, to output the 
decoded AURO-3D® mix. 
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↓

Figure 2 - 20 | Auro-Matic Pro 3D Plugin Insertion
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For more detailed information about the functioning of the Auro-Decoder plugin, please refer to chapter 
3.7 of the AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).

Pro Tools Routing

Auro-Decoder plugins can be inserted on Audio Tracks (recommended) or Aux Tracks using any formats 
from “mono” to “7.1”. The Auro-Mixing Engine assignment menu, located in the bottom right corner of the 
Auro-Decoder allows to connect the output of the Auro-Decoder to an Auro-Mixing Engine. This enables 
monitoring of the decoded channels and the original mix through the Auro-Return plug-ins already 
connected to the Auro-Mixing Engine. This plugin acts as a quality control feature and is not designed to 
be used along other audio plugins within the track.  
 
The output module of any Auro-Panner tracks must be assigned to the “Dummy” virtual bus. If using HD 
or HDX Audio Systems, a DSP plug-in must be inserted and activated on the first Insert slot of the track 
before inserting the Auro-Panner plugin. A simple mono or multi-mono DSP Trim plugin (Avid native) set 
as default is recommended.


2.6.4	 Auro-Bus Tracks 

Purpose of the Plugin


In addition to the default “Main Bus”, additional Auro-Buses can be created for additional routing and 
grouping functions. Therefore, the Auro-Buses collect panned information from a number of Auro-Panner 
and Auro-Matic Pro plugins to form a subgroup or stem before delivering them to the Auro-Mixing Engine. 
These buses also act as Groups for Interactive Programs that are accessible from the Auro-Mixing 
Engine. 


For more detailed information about the functioning of the Auro-Bus plugin, please refer to chapter 3.2 of 
the AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).


For more detailed information about Groups in Programs, please refer to the corresponding chapter:  
→ Chapter 3.7.1.4

Pro Tools Routing

Auro-Bus plugins can be inserted on Audio Tracks or Aux Tracks using any formats. The type of track and 
its format have no influence on their behaviour. These plugins do not treat any audio signals on the track 
wherein they are inserted. Multiple Auro-Bus plugins can be inserted on the same track and additional 
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Figure 2 - 21 | Auro-Buses in the Auro-Mixing Engine
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ones if necessary. The output module of any Auro-Bus tracks must be assigned to the “Dummy” virtual 
bus. 


If using HD or HDX Audio Systems, a DSP plug-in must be inserted and activated on the first Insert slot 
of the track before inserting the Auro-Panner plugin. A simple mono or multi-mono DSP Trim plugin (Avid 
native) set as default is recommended.

2.6.5	 Auro-Downmix Control Tracks 

Purpose of the Plugin


The Auro-Downmix Control plugin allows to creatively and dynamically control the down-mix that encodes 
AURO-3D® content into a 5.1 Surround or four-channel carrier and allows to control the non-encoded 
down-mix.


Unlike the Downmix Settings in the Auro-Mixing Engine (accessible in the Settings tab), the Auro-
Downmix Control lets you automate the channel gain attenuations so you have complete dynamic 
control. When the encoded carrier plays through a 5.1 surround system, these gains determine how the 
source channels are mixed together. 


One Auro-Downmix Control must be selected in the Settings tab of the Auro-Mixing engine. An Auro-
Return plugin must output “Channel Downmix” in order to listen to the modifications operated by the 
selected Auro-Downmix Control.
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Figure 2 - 22 | Auro-Downmix Control Configuration





 

For more detailed information about the functioning of the Auro-Downmix Control plugin, please refer to 
chapter 3.6 of the AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).

Pro Tools Routing

Auro-Downmix Control plugins can be inserted on Audio Tracks or Aux Tracks using any formats. The 
type of track and its format have no influence on their behaviour. These plugins do not treat any audio 
signals on the track wherein they are inserted. Multiple Auro-Downmix Control plugins can be inserted on 
the same track and additional ones if necessary. The output module of any Auro-Down-mix Control tracks 
must be assigned to the “Dummy” virtual bus.

2.6.6 Auro-Mixing Engine Track 

Purpose of the Plugin


The Auro-Mixing Engine plug-in lies at the heart of the AURO-3D® workflow and performs the following 
functions: 


• Receives audio from connected Auro-Bus plug-ins in addition to the Auro Main Bus.


• Contains the AURO-3D® Encoder. 


• Outputs mixes and derived down-mixes to the Auro-Return plug-ins.


• Sets the Bed configuration. → Chapter 3.3.3

• Loudness Measurement that ensures the immersive mix, derived down-mixes and interactive 
programs comply to the EBU R128 guidelines. → Chapter 3.5

• New Monitoring functions providing a unique ability to switch between different versions of the mix, 
all on the same monitoring setup. → Chapter 3.4

• Mix Profiles that ensure the compatibility of the mix with supported features and limitations of the 
target deliverable. → Chapter 3.3.1

• Multiple Programs/Presentations, with support for multiple languages, auxiliary tracks, commentary 
tracks and much more in a single audio stream. → Chapter 3.7

• Interactive Dialog Enhancement through Interactive Gains. → Chapter 3.7.2.3

• Auro's all new and patent-pending rendering algorithms with room-centric panning, ensuring that all 
mixes are translated as intended, from playback in studio, to cinema theaters, home systems and 
mobile devices.


• Ability to export ADM BWF-files with support for the Emission Profile, according to ITU-R 
Rec.BS.2076. → Chapter 3.8.1.1

• Ability to export IAB files with AuroMax for Digital Cinema using SMPTE IAB (ST 2098-2).  
→ Chapter 3.8.1.2 

• Quality Control feature with Import and Playback of SMPTE IAB and ADM files. → Chapter 3.8.3

The Auro-Mixing Engine output can be monitored by routing it to one or more Auro-Return plug-ins.
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The features from the former "Encoder" tab from the previous versions are now available in the 
new “Export” tab in version 3.0 (“Auro-Codec encoded” type). 

For more detailed information about the standard features of the Auro Encoder, please refer to chapter 
8.3.2 in the the AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).


For more detailed information about the standard features of the Auro-Mixing Engine plugin, please refer 
to chapter 3.3 in the AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring 
Tools Documentation).

Pro Tools Routing

At least one, but only one, Auro-Mixing Engine plugin must be inserted on an Audio Track. It is 
recommended to use a track in the 7.1 format. This plugin is not designed to be used along other audio 
plugins within the track. 
 
The input module must be assigned to the “Fader Link” virtual bus and the output module must be 
assigned to the “Dummy” virtual bus. If using HD or HDX Audio Systems, a DSP plug-in must be inserted 
and activated on the first Insert slot of the track before inserting the Auro-Panner plugin. A simple mono 
or multi-mono DSP Trim plugin (Avid native) set as default is recommended.

2.6.7 Auro-Return Tracks


Purpose of the Plugin

These plugins bring processed audio back to the DAW and must be properly configured to receive and 
output relevant audio materials. If using Audio Tracks to insert the Auro-Return plugins, the input button 
“I” of the Pro Tools track must be activated in order to listen to the audio source. It is also possible to print 
the stems by recording on Audio Tracks.

New output’s options are now available in 3.0: → Chapter 3.9

For more detailed information about the standard features of the Auro-Return plugin, please refer to 
chapter 3.5 in the AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).


Pro Tools Routing

Auro-Return plugins can be inserted on Audio Tracks or Aux Tracks (recommended) using any formats 
from “mono” to “7.1”. Multiple Auro-Return tracks can be created in order to output desired output paths 
created in the I/O setup of Pro Tools using the output modules of the tracks. These plugins bring 
processed audio back to the DAW and must be properly configured to receive and output relevant audio 
materials. If using Audio Tracks to insert the Auro-Return plugins, the input button “I” of the Pro Tools 
track must be activated in order to listen to the audio source. It is also possible to print the stems by 
recording on Audio Tracks. 


If using HD or HDX Audio Systems, a DSP plug-in must be inserted and activated on the first Insert slot 
of the track before inserting the Auro-Panner plugin. A simple mono or multi-mono DSP Trim plugin (Avid 
native) set as default is recommended.

————

For more detailed information about the Auro-Aux plugin, please refer to chapter 8.4 in the  
AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).

For more detailed information about Fader Link, please refer to chapter 3 in the AURO-3D® 

Authoring Tools - User Guide (→ Link to AURO-3D® Authoring Tools Documentation). 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Chapter 3:	 Features in 3.0 

3.1	 AuroMax Speaker Positions File 

The AuroMax Speaker Positions File is a text file accessible from the Auro Technologies folder 
(Macintosh HD > Library > Application Support > Auro Technologies > AuroMaxSpeakerPositions.txt).  
 
This file allows to set custom positions for the speakers used in an AuroMax Configuration. Further 
details about the setup procedure can be requested via the Support service at →  https://support.auro-
technologies.com/.

3.2	 Speaker Configuration Drop Down Menu 
 
The selected Speaker Configuration must correspond to the hardware setup as it defines how the mix 
will be monitored. The Speaker Configuration Drop Down Menu is accessible from the Auro-Settings 
menu bar application: 


  
 

The selected Speaker Configuration filters monitoring’s options in the Auro-Mixing Engine (see 
chapter 3.4 “Monitoring Configuration” for more explanation → Chapter 3.4).  

 
The Speaker Configuration is system-wise, which means that the selected configuration is not 
saved or loaded by DAW session data. 


The Speaker Configuration must be the first option to examine and configure before using the 
Auro Creative Tools.
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Figure 3 - 1 | Speaker Configuration in the Menu Bar 
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3.3	 Mix Settings 
 

The Mix Settings define the target application and features of the mix and are accessible from the 
Settings tab in the Auro-Mixing Engine plugin. 


 
3.3.1	 Mix Profile Drop Down Menu


 

Mix Profiles set mix settings according to the nature of the project. One mix profile must be selected in 
order to benefit from adequate mixing options. Mix profiles define: 


• The maximum number of objects that can be used.


• The ability to use interactive programs or not.


• The available export options.


• Calibration levels of Surround channels in beds.

More information about objects system in chapter 3.6. → Chapter 3.6  
More information about bed configurations in chapter 3.3.3. → Chapter 3.3.3  
More information about programs management in chapter 3.7. → Chapter 3.7  
More information about export options in chapter 3.9. → Chapter 3.9  

 
There are five mix profiles: 


• Cinema AuroMax: Profile intended for theatrical mixes when using AuroMax configurations.


• Cinema Auro 3D: Profile intended for theatrical mixes when using Auro 3D configurations.


• NearField Full: Profile intended for NearField monitoring with little limitations.


• NearField Home: Profile intended for home entertainment releases.


• NearField Broadcast: Profile intended for broadcast releases.
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Figure 3 - 2 | Mix Settings tab in Auro-Mixing Engine

Figure 3 - 3 | Mix Profile Drop Down Menu in Auro-Mixing Engine





 

Specifications of Mix Profiles:  

 
The Bed Surround Level in Table 3 - 1 corresponds to the calibration level for the Surround channels. 
The Creative Tools version 3.0 currently support only one bed per mix. Profiles supporting more than one 
bed will be provided in next versions.

3.3.2	 Mix Profile Specifications List  

The specifications of the selected Mix Profile are shown in the Mix Profile Specification List. The third 
criteria “Interactivity” refers to the ability to use Programs.   


 

 

Mix Profiles Max Objects Max Beds Export Formats Bed Surround Level
Cinema AuroMax 128 1 Wav | AuroMax 85dB
Cinema AURO-3D® 0 1 Wav | Auro-Codec 82dB
Nearfield Full 64 1 Wav | Auro-Codec | AuroMax | ADM 85dB
Nearfield Home 10 1 Wav | Auro-Codec | AuroMax | ADM 85dB
Nearfield Broadcast 1 1 Wav | Auro-Codec | AuroMax | ADM 85dB
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Table 3 - 1 | Mix Profiles Specifications

↓ ↓ ↓ ↓ ↓

Figure 3 - 4 | Mix Profile Specifications List in the Auro-Mixing Engine 





 

3.3.3	 Bed Config Drop Down Menu  

 


 
 
The bed corresponds to the format of the channel-based element in the mix. 

The configurations that are available in the menu depend on the selected Mix Profile.


 
The following table highlights the available bed configurations according to the selected Mix Profile:  
 

Cinema 
AuroMax

Cinema 
Auro 3D

NierField Full NierField Home NierField 
Broadcast

Mono ✓ ✓ ✓

Stereo ✓ ✓ ✓

LCR ✓ ✓ ✓

LCRS ✓ ✓ ✓

QUAD ✓ ✓ ✓

OnScreen 2-2H ✓ ✓ ✓

Surround 5.0 ✓ ✓ ✓

Surround 5.1 ✓ ✓ ✓

Surround 6.0 ✓ ✓ ✓

Surround 6.1 ✓ ✓ ✓

Surround 7.0 ✓ ✓ ✓

Surround 7.1 ✓ ✓ ✓

Auro 2-2-2 ✓ ✓ ✓

Auro 8.0 ✓ ✓ ✓

Auro 9.1 ✓ ✓ ✓

Auro 10.1 ✓ ✓ ✓

Auro 11.1 ✓ ✓ ✓ ✓ ✓

Auro 11.1 (7.1+4H) ✓ ✓ ✓

Auro 13.1 (7.1+5H+T) ✓ ✓ ✓ ✓ ✓
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Figure 3 - 5 | Bed Config Drop Down Menu in Auro-Mixing Engine

SELECTED MIX PROFILE
AVAILABLE 
BED CONFIG

Table 3 - 2 | Compatible Bed Configurations with Mix Profiles





 

 
3.4	 Monitoring Configuration 
 
 

The Monitoring Configuration is accessible from the Controls tab in the Auro-Mixing Engine plugin and is 
used to select the version of the mix that is monitored on the installed speaker system:

 

3.4.1	 Monitoring Configuration Drop Down Menu  

 



 
The Monitoring Configuration Drop Down Menu let the user simulate a desired speaker configuration 
even if the real configuration is different. This option is particularly useful to examine the different down-
mix behaviours. Only configurations equal to or lower than the actually installed speaker system will be 
available. 


If the selected Monitoring Configuration is different from the Bed Configuration, a message “Mismatch 
between Bed and Monitoring config” is displayed above the drop down menu to remind users that the 
monitored version is not equal to the actual mix version.


The meters will reflect the levels of the different channels in the selected Monitoring Configuration. 
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Figure 3 - 6 | Monitoring Configuration in the Auro-Mixing Engine

Figure 3 - 7 | Monitoring Configuration Drop Down Menu

Figure 3 - 8 | Monitoring Configuration Mismatch Message





 

 
The selected monitoring configuration can be auditioned by setting the Auro-Return plugin to “Monitoring” 
in the Output Drop Down Menu:  

More information about the Auro-Return plugin version 3.0 can be 
found in chapter 3.9. 

The available Monitoring Configurations depends on the selected 
Speaker Configuration.


The following table highlights the available Monitoring Configurations according to the selected Speaker 
Configuration: 

Stereo Surround 
5.1

Surround 
7.1

Auro 
9.1

Auro 
11.1

Auro 
11.1 

(7.1+4H)

Auro 
13.1

Auro 
11.1 

Cinema

Auro 
13.1 

Cinema

AuroMax 
20.1

AuroMax 
22.1

AuroMax 
26.1

Mono ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Stereo ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

LCR ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

LCRS ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

QUAD ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

OnScreen 2+2H ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Surround 5.0 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Surround 5.1 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Surround 6.0 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Surround 6.1 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Surround 7.0 ✓ ✓ ✓ ✓ ✓ ✓

Surround 7.1 ✓ ✓ ✓ ✓ ✓ ✓

Auro-222 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Auro 8.0 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Auro 9.1 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Auro 10.1 ✓ ✓ ✓ ✓ ✓ ✓ ✓

Auro 11.1 ✓ ✓ ✓ ✓ ✓ ✓ ✓

Auro 11.1 
(7.1+4H) ✓ ✓ ✓ ✓ ✓ ✓

Auro 13.1 
(7.1+5H+T) ✓ ✓ ✓ ✓ ✓

Atmos ✓ ✓ ✓ ✓ ✓

AuroMax 20.1 ✓ ✓ ✓

AuroMax 22.1 ✓ ✓

AuroMax 26.1 ✓
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Figure 3 - 9 | Monitoring Output in Auro-Return Plugin
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Table 3 - 3 | Compatible Bed Configurations with Mix Profiles





 

3.4.2	 Monitoring Configuration Filters Drop Down Menu


The Filters Drop Down Menu allows to filter different kinds of audio sources processed by Auro-Panner 
plugins. It is set to “All” by default. There are three possible filters:


• Bed: Only channel-based audio elements are monitored. 


• Objects: Only object-based audio elements are monitored. 


• All: Both channel-based and object-based audio elements are monitored. 
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Figure 3 - 10 | Monitoring Configuration Filters Drop Down Menu





 

 
3.5	 Loudness Metering 
 
The Loudness Metering area is accessible from the Controls tab in the Auro-Mixing Engine plugin:


 

 
The Auro-Mixing Engine provides LUFS meters (Loudness Unit Full Scale). LUFS takes human 
perception of hearing into account thanks to measurements of Momentary Loudness, Short Term 
Loudness, Integrated Loudness, Loudness Range and True Peaks.


• Momentary Loudness (M) measures the loudness of the past 400 Milliseconds. 


• Short-Term (S) measures the loudness of the past 3 Seconds.


• Integrated Loudness (I) is a measurement taken from beginning to end of the audio material, 
indicates the total average volume.


• Loudness Range (LRA)  quantifies, in LU, the dynamic range of the mix as the statistical 
distribution of short term loudness. 


• True Peak (Peak) indicates accurate measurements of inter-sample peaks.

3.5.1	 Loudness Metering Drop Down Menu
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Figure 3 - 11 | Monitoring Configuration in the Auro-Mixing Engine

Figure 3 - 12 | Loudness Drop Down Menu in the Auro-Mixing Engine





 

 
The drop down menu displays two main groups of options: 


• MSI Group: This group allows to select which version of the mix (Mix, Down-mix or Stereo) is  
measured and will show Momentary, Short-term and Integrated meters (M, S and I). 

 

• Comparison’s Group: This group allows to select a specific measurement (Integrated, Short-
term, Momentary or Peak) that is shown for the different versions of the mix simultaneously 
(2.0, Down-mix and Mix).

3.5.2	 LRA Meter Value


The LRA Meter Value displays the Loudness Range of the selected mix version in the Loudness drop 
down menu. 
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→{MSI Group

Figure 3 - 13 | MSI Group in Loudness Drop Down Menu

→{Comparison Group

Figure 3 - 14 | Comparison Group in Loudness Drop Down Menu

Figure 3 - 15 | LRA Meter Value in Loudness Area





 

 
3.5.3	 Reset Button 

The Reset Button resets all loudness measurements.

3.6	 Objects  

Objects are individual sounds with related metadata defining the position of the sound in the sound-field. 
Depending on the selected export format, these will be transmitted separately from the channel-based 
bed and rendered during playback, adapting to the playback environment (from small home 
environments to large cinema theaters).

3.6.1	 Object Button 

 

The Object button can be enabled in the Controls tab of any Auro-Panner plugin. As a result, the audio 
processed by this Auro-Panner plugin is then treated and rendered as an object.  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Figure 3 - 16 | Reset Button in Loudness Area

Figure 3 - 17 | Object Button in Auro-Panner Plugin

Figure 3 - 18 | Object Button “Too Many Objects !” Message





 

The maximum number of objects that can be used in a mix depends on the selected Mix Profile. If the 
maximum number of object is reached, a red message “Too Many Objects !” is displayed next to all object 
buttons.


When activated, the object button modify, disable and enable certain options in the Auro-Panner:

 

1. Disable LFE send (only if Export Type is set to “ADM” in the Export tab).


2. Modify regular Spread Parameters to single Object Spread Parameter.


3. Disable C%, HC% and T% parameters. 


4. Enable Snap option (except if Export Type is set to “ADM” in the Export tab).


5. Enable Active Object-Rendering Zones option (except if Export Type is set to 
“ADM” in the Export tab).	


6. Enable Object Metadata option.


7. Modify panning behaviour for AuroMax Configurations (gradual movement). 
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Figure 3 - 19 | Object Auro-Panner Options





 

 
3.6.2	 Snap Button


When the Snap Button is activated, the object will be played back from the closest speaker instead of 
panning smoothly between the speakers. This is especially useful if the sound colour of the object’s audio 
is more important than its actual position. 

 
 
The Snap Button is not accessible if the Export Type is set to ADM-File.

3.6.3	 Object Metadata


 
The Object Metadata options are accessible from the Settings tab in the Auro-Panner. 


3.6.3.1	 Object Kind Drop Down Menu
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Figure 3 - 20 | Snap Button

Figure 3 - 21 | Object Metadata in Auro-Panner Settings Tab

Figure 3 - 22 | Object Kind Drop Down Menu





 

The Object Kind Drop Down Menu allows to select one object's categorisation that will be used in the 
corresponding metadata fields supported by the selected Export format.


3.6.3.2	 Object Language Drop Down Menu

The Language Drop Down Menu allows to assign a language to the object. This information will be 
exported in metadata and is particularly useful when using Switch Groups in Programs. 

 

More information about Switch Group can be found in chapter 3.7.2.5. → Chapter 3.7.2.5 
More information about Programs can be found in chapter 3.7. → Chapter 3.7

3.6.4	 Active Object-Rendering Zones 

Active Object-Rendering Zones or Zone Control allows users to define whether certain zones can/may be 
used during the rendering of an object or not.

 
The Active Object-Rendering Zones option is not accessible if the Export Type is set to ADM-File.
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Figure 3 - 23 | Language Drop Down Menu

Figure 3 - 24 | Active Object-Rendering Zones in Auro-Panner





 

3.6.4.1	 Zones Presets

Zones presets allows to restrict the positions of objects by selecting predetermined configurations. If  
restrictions are set manually, the preset will be defined as “Custom”.


3.7	 Programs 

In the Programs tab in the Auro-Mixing Engine, Programs that correspond to different sets of audio 
content and interactive features for the audience can be configured. For instance, interactivity can include 
the ability for listeners to adjust dialogue levels, select different languages or mute certain categories of 
sound.  

The Programs tab is not accessible when using Cinema Auro 3D Mix Profile or Cinema AuroMax 
Mix Profile in the Mix Settings. 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Figure 3 - 25 | Zones Presets

Figure 3 - 26 | Programs tab in Auro-Panner Plugin





 

3.7.1	 Programs Table 

The Programs table contains columns and rows. Each row correspond to one specific program. Columns 
allow to select, examine integrated loudness and configure groups in programs.

3.7.1.1	 Play Column

 

The “Play” Column let users select one existing program by activating the corresponding green button. 


3.7.1.2	 Programs Column

 

The “Programs” Column displays all available programs. It allows users to create, delete and rename 
programs. 


• Add Program: Programs can be added by right clicking the Programs header and select “Add 
Program” in the contextual drop down menu. 


• Delete Program: To delete Programs, right-click the Programs header and select “Delete 
Selected Program” in the contextual drop down menu.


• Rename Program: Any program can be renamed by double clicking its name in the list.  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Figure 3 - 27 | Programs Table

Figure 3 - 28 | “Play” Column in Programs Table

Right Click

Figure 3 - 29 | “Programs” Column in Programs Table





 

 
3.7.1.3	 PL (LUFS) Column

PL (LUFS) stands for “Program Loudness” and displays integrated loudness measurement for each 
program respectively. All PL can be reseted by pressing the Reset Button in the controls tab of the Auro-
Mixing Engine. 

3.7.1.4	 Groups

In addition to the default Main Bus, every Auro-Bus is shown in its own column. In the context of 
Programs, these Auro-Buses become “Groups”. For each Program Objects and channel-based audio 
elements are added by activating the “O” and “C” buttons.

 


 


For instance, if only the “O” button is activated for the group “Ambience”, only Object Auro-Panners 
routed to the “Ambience” bus will be audible within the selected Program. If only the “C” button is 
activated for the group “Ambience”, only Channel-Based Auro-Panners routed to the “Ambience” bus will 
be audible within the selected Program.
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Figure 3 - 30 | “PL (LUFS)” Column in Programs Table

Figure 3 - 31 | Groups in the Programs Table

Figure 3 - 32 | Possible Assignments in Groups

Silence Channel-Based  
Only

Objects 
Only

Objects and  
Channel-Based





 

As ADM exports only support a single bed, each group must “vertically” share the same channel-
based configuration for all programs. Nevertheless, it is still possible to “horizontally” set no 
channel-based content for all groups in one program. Objects are not affected by this rule. 
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Auro-Panner “Bird” 
Object.

Auro-Panner 
“Wind”  Routed to the 

“Ambience” Auro-Bus. 
Corresponds to the 
Group named 
“Ambience” in the 
Programs Table.

In the program named “Ambience”, if 
the group named “Ambience” allows 
objects only, then only the “Bird” 
object is audible.

In the program named “Ambience”, if 
the group named “Ambience” only 
allows channel-based content, then 
only the channel-based “Wind” is 
audible. 

Only “Bird” 
is Audible.

Only “Wind” 
is Audible.

Figure 3 - 33 | Example of Program Configuration

Channel-based content in all groups.

Supported Bed Distribution:

✓

Channel-based content in certain groups.

✓

No channel-based content in certain 
programs (Option + Click).

✓

Unsupported Bed Distribution:

Different channel-based content in 
programs within the same group is not 
currently possible.

✗

Not Supported.

Figure 3 - 34 | Supported and Unsupported Bed Distribution





 

Channel-based and object buttons can be horizontally activated/deactivated using Option + Click. 
Channel-based and object buttons can be vertically activated/deactivated using Shift + Click.

 
 
 

3.7.2	 Interactivity Button 

The interactivity button displays all interactive options that are currently available in the currently selected 
Program (Interactive Gains, Interactive Gain Offsets, Allow Mute Buttons and Switch Groups). The values 
of any interactive parameters can be modified by the mixer in real time. This interface does not reflect 
what the end user will see but rather lets the mixer test the current interactive content of the project 
before exporting the ADM-File.  
 
Interactive options are present in the interactivity area only if one or several Groups within the selected 
Program have been previously configured to support them. Any interactive options can be configured via 
the Group Settings of any Auro-Buses. As a reminder, Auro-Buses become the so-called “Groups” in the 
context of Programs.      
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Shift + Click: Vertical ActivationOption + Click: Horizontal Activation

Figure 3 - 35 | Activation Keyboard Shortcuts in Programs

Figure 3 - 36 | Interactivity Button in the Programs Tab of the Auro-Mixing Engine Plugin





 

3.7.3	 Group Settings


 
 
The Group Settings panel is accessible in any Auro-Bus Plugin. It allows users to configure metadata and 
interactivity for the Group within Programs.  

 
Group Settings are not accessible when using Cinema AURO-3D® Mix Profile or Cinema 
AuroMax Mix Profile in the Mix Settings. 

3.7.3.1	 Group Kind Drop Down Menu

The Group Kind Drop Down Menu allows to select one group's categorisation that will be exported in 
metadata.

3.7.3.2	 Group Language Drop Down Menu
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Figure 3 - 37 | Group Settings in Auro-Bus Plugin

Figure 3 - 38 | Group Kind Drop Down Menu

Figure 3 - 39 | Group Language Drop Down Menu





 

The Language Drop Down Menu allows to assign a language to the group that will be exported in 
metadata. The list of available languages can be defined in the AURO Language Selector Application 
(see → Chapter 2.3)


3.7.3.3	 Interactive Gain Button

 

When activated, the Interactive Gain Button makes the volume of the group interactive by creating a 
dedicated gain parameter. The range of this gain parameter can be set using the “Min” and “Max” 
parameters. This gain parameter is accessible in the Programs tab of the Auro-Mixing Engine Plugin. 
Listeners will also benefit from this interactive gain parameter through ADM export. 

 
 

 
Only 4 Gain Parameters can be displayed in the programs tab at the same time. Only objects can 
benefit from Interactive options. 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Figure 3 - 40 | Interactive Gain and Gain Parameters

Figure 3 - 41 | Interactive Gain in Auro-Mixing Engine





 

3.7.3.4	 Interactive Gain Offset

The Interactive Gain Offset allows to set a default value for the active Interactive Gain of any Group 
within any Program respectively. As a result, the end user will automatically hear the corresponding 
volume offsets when selecting any Program where such values have been configured.    
 
The current values of the Gain offsets are accessible next to each Group from the Programs Table in the 
Programs tab of the Auro-Mixing Engine. They correspond to the coefficients that are set to “0” by default.

The Interactive Gain Offset can be modified only if the targeted Group supports the Interactive Gain 
option (that can be activated via the Group Settings of the corresponding Auro-Bus), only if the range of 
the corresponding Gain parameter has been configured to any values greater than zero (range that can 
also be configured via the Group Settings of the corresponding Auro-Bus), and only if the blue Object 
Button “O” is activated within the targeted group (button that is directly accessible via the content 
distribution of the Programs Table in the Auro-Mixing Engine).  
 
If all these conditions are respected, a default value for each Interactive Gain can be set by double 
clicking the “0” coefficient next to one group, typing the desired value and eventually confirming by 
pressing the “Enter” key.  


Once an Interactive Gain Offset has been configured and if the value of the corresponding Gain 
Parameter is modified during playback, the flashing Interactive Gain Offset Led Indicator lets the mixer 
know that the current value of the Interactive Gain Parameter is not equal to the Interactive Gain Offset 
value. 
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Figure 3 - 42 | Interactive Gain Offsets in the Programs Table of the Auro-Mixing Engine

Gain Off

Corresponding  
Gain Parameter  
Set to Default

Corresponding  
Gain Parameter  
Set to Another  
Value

Interactive Gain 
Off

Figure 3 - 43 | Interactive Gain Offsets Led Indicator in the Auro-Mixing Engine





 

3.7.3.5	 Allow Mute Button

When activated, the Allow Mute Button creates a new interactive button that can mute the group. 
Listeners will also benefit from this interactive Mute Button through ADM export.

3.7.3.6	 Switch Group Button

When activated, the Switch Group Button turns the selected Bus into a Switch Group. As a consequence, 
the name of this group is followed by the label “(Sw)” in the Programs tab of the Auro-Mixing Engine. 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Figure 3 - 44 | Allow Mute Button in Group Settings

Figure 3 - 45 | Allow Mute Button in Auro-Mixing Engine

Figure 3 - 46 | Switch Group Button in Group Settings





 

 
Only one switch group is supported per program.  
 
 

If at least one Object Panner is connected to the Switch Group and If this Switch Group accepts objects 
(“O” button), the Programs tab in the Auro-Mixing Engine displays a Switch List where users can select 
different audio sources. Here is an example for dialogue switch: 
 

 
 
 
 
 

 
 
Default audio source in a Switch Group can be set using “Option + Click”.
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Figure 3 - 47 | Switch Group Label in Programs Table

Figure 3 - 48 | Example of Switch Group

Object Panner (English). 
Routed to the Dialogues Bus.

Object Panner (Dutch). 
Routed to the Dialogues Bus.

Object Panner (Chinese). 
Routed to the Dialogues Bus.

Object Metadata in the 
Settings tab (English).

Object Metadata in the 
Settings tab (Dutch).

Object Metadata in the 
Settings tab (Chinese).

Dialogues Auro-Bus. 
Switch Group Activated.

Switch List of the Switch Group in the 
Programs tab of the Auro-Mixing Engine.





 

3.7.4	 Program Labels Button 

The Program Labels Button is accessible from the Programs tab of the Auro-Mixing Engine. Program 
Labels allow to optionally name each program in different languages. The available languages can be 
configured thanks to the Auro Language Selector standalone application that is accessible from the Auro-
Settings menu bar application. This feature ultimately gives the end user application the ability to choose 
in which language he wants to read the names of each program (e.g., following a set-top box’ default 
Language setting).

After selecting one Program in the Programs Table, this Program becomes highlighted in red. Therefore, 
each default Program Label of the selected Program is displayed in the Labels area. These Labels can 
be modified by double clicking them, renaming them for each available language and eventually pressing 
the “Enter” key to confirm.  
 
Each language for the Program Labels that will be exported in the metadata of the ADM-File can be 
included or not thanks to the green checkboxes. 
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Figure 3 - 49 | Program Labels Button

Language that will not be Included in the exported Metadata of the ADM-File

Language that will be Included in the exported Metadata of the ADM-File

Figure 3 - 50 | Green Checkboxes for Each Language of the Program Labels





 

3.8	 Exports 
 
 
 
 

The Auro-Mixing Engine contains an Export Tab to where users can export the project and select a 
desired export format.


3.8.1	 Type Drop Down Menu 

The Creative Tools Suite version 3.0 introduces three new export types: 

• WAV-Files: Bed export in Waveform Audio File Format. 


• ADM-File (ITU-R Rec. BS.2076): Audio Definition Model (recommend for broadcasting 
service).


• AuroMax (SMPTE ST2098-2): AuroMax (standard for immersive audio). 
 


The features from the former "Encoder" tab from the previous versions are now available in the 
new “Export” tab in version 3.0 (“Auro-Codec encoded” type). 

For more detailed information about the standard features of the Auro Encoder, please refer to chapter 
8.3.2 in the  AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring Tools 
Documentation).


3.8.1.1	 WAV-Files
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Figure 3 - 51 | Export Tab in Auro-Mixing Engine

Figure 3 - 52 | Type Drop Down Menu in the Export Tab

Figure 3 - 53 | WAV-Files Type in the Export Tab

file:///Library/Application%20Support/Auro%20Technologies/Documentation/Auro-3D_Authoring_Tools_Documentation.pdf
file:///Library/Application%20Support/Auro%20Technologies/Documentation/Auro-3D_Authoring_Tools_Documentation.pdf




 

The WAV-Files Export Type allows to export the current mix into Waveform Audio Files Format. Each 
resulting file correspond to one distinct channel. The number of exported channels is defined by the 
selected Be d Configuration. In addition to write the regular channel-based content, this process also 
write and sum Objects mixes into the channel-based content. 


If using Interactive Programs, only the audio elements that are activated in the selected program will be 
exported.


3.8.1.2	 ADM-File

Audio Definition Model (ADM) is a format based on BWF-files and intended for broadcasting services. 
The exported file is designed to describe audio content and carries all information related to programs 
configuration.


 
ADM format does not support Active Object-Rendering Zones and Snap options in the Auro-
Panner plugins. 


3.8.1.2.1	 Emission Profile Button

 
 
The ADM Broadcast Emission profile defines a complete subset of the Audio Definition Model which limits 
the scope of ITU-R BS.2076 to features typically used in low-bitrate audio codecs for Next Generation 
Audio. When activated, the Emission Profile Button set restrictions for the ADM-file export to ensure its 
compatibility.  

3.8.1.3	 AuroMax
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Figure 3 - 55 | ADM-File Type in the Export Tab

Figure 3 - 56 | Emission Profile Button

Figure 3 - 57 | AuroMax Type in the Export Tab

Figure 3 - 54 | Exported Bed Configuration in Waveform Audio Format

→





 

The AuroMax export defines a bitstream to carry immersive audio. It results in an IAB file (Immersive 
Audio Bitstream). The maximum number of objects is limited to 118.


3.8.1.3.1	 Files per Frame Button

The SMPTE ST2098-2 encodes audio and metadata into synchronisation blocks called “frames”. Each 
frame corresponds to a video frame as defined in the selected Frame Rate from the corresponding Drop 
Down Menu (→ Chapter 3.8.1.3.3). Activating the Files per Frame button results in  the selected 
generating one file per frame.


3.8.1.3.2	 Audio Encoding Drop Down Menu

The audio in the IAB bitstream can be encoded as uncompressed PCM or losslessly compressed in the 
DLC-format.


3.8.1.3.3	 Frame Rate Drop Down Menu

The Frame Rate Drop Down Menu allows to specify the frame rate for AuroMax Export. It is therefore 
possible to export the mix with different frame rates.   
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Figure 3 - 58 | Files per Frame Button

Figure 3 - 59 | Audio Encoding Drop Down Menu

Figure 3 - 60 | Frame Rate Drop Down Menu





 

 
3.8.1.4	 Auro-Codec Encoded

The Auro-Codec Encoded export type let users create Auro-Encoded files, for example to encode an 
Auro 11.1 mix into a Auro-Encoded 5.1 carrier with the Pro Tools mix session as the source. For more 
detailed information about the standard features of the Auro Encoder, please refer to chapter 4 and 
chapter 8.3.2 in the  AURO-3D® Authoring Tools - Reference Manual (→ Link to AURO-3D® Authoring 
Tools Documentation).   


3.8.1.4.1	 Encoding Progress




The Encoding Progress feature is accessible from the Auro-Settings menu bar application.


• Encoding Progress List: Each Auro-Codec Encoded export is listed in the Encoding 
Progress list. After exporting the mix, this menu monitors the progress of each encoding 
process in real time from 0% to 100%.   


• Clear Encoding History Option: It is possible to clear the Encoding Progress list by clicking 
the Clear Encoding History Option or by using the keyboard shortcut CMD + C.


• Show in Finder Option: Each Auro-Codec Encoded export can be revealed in the finder by 
clicking the Show in Finder Option.


• Abort Option:  It is possible to abort any encoding process in progress by clicking the Abort 
Option.
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Figure 3 - 61 | Encoding Progress in the Auro-Settings Menu Bar Application

file:///Library/Application%20Support/Auro%20Technologies/Documentation/Auro-3D_Authoring_Tools_Documentation.pdf
file:///Library/Application%20Support/Auro%20Technologies/Documentation/Auro-3D_Authoring_Tools_Documentation.pdf




 

3.8.2	 Export Button

 
 

After defining an Export Path, typing an Export Name and selecting the desired format in the Type Drop 
Down Menu, users can export the project using the Export Button. When activated, the button’s colour 
turns yellow to indicate that the project is ready to be exported. Playing and stopping the playhead 
executes the export in real time. 


 

3.8.3	 Quality Control

 
The Creative Tools Suite version 3.0 introduces a new Quality Control system. This can be used to check 
exports in the ADM and IAB formats. 


3.8.3.1	 Load File Button

The Load Button allows to import one external file. When loaded, the name of the file is displayed above 
the Load File button.


 
The content of the file is not imported into the Pro Tools session! Nevertheless, the loaded file 
can be rendered using the Render Button (see next chapter → Chapter 3.8.1.3.2)
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Figure 3 - 62 | Export Button in the Export Tab

Figure 3 - 63 | Exported File in Finder

Figure 3 - 64 | Load Button in the Export Tab

Figure 3 - 65 | Imported File in the Export Tab





 

3.8.3.2	 Render Button

 
The Render Button operates as a quality control. Loaded files can be rendered in order to examine their 
content. If an imported file that contains programs is rendered, the name of the file is displayed above the 
Programs Table where its available programs can be selected and read. Pressing the yellow Render 
Button again stops the rendering process of the imported file.


 
The rendered file is always starting at timecode 00:00:00:00.  

It is recommended to render imported files in a brand new DAW session dedicated for quality 
control. 

3.9	 Auro-Return 
 
The Creative Tools Suite version 3.0 introduces new outputs in the Auro-Return plugin.


• Monitoring.


• Bed Mix

• Objects Mix. 
 


"Mix" option from previous versions is now renamed "Channel Based Mix” in CTS version 3.0 ! 
"Down-mix" option from previous is now renamed "Channel Down-mix” in CTS version 3.0 !
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Figure 3 - 66 | Render Button in the Export Tab

Programs Before Exporting an ADM File. Rendered ADM File in Programs Tab.

Figure 3 - 67 | Rendered File in Programs Tab





 

3.9.1	 Output Drop Down Menu


The Output Drop Down Menu is accessible from the Auro-Return plugin. 


The “Encoded” and “Encoded + Decoded” outputs are only available when the Export Type is set 
to “Auro-Codec encoded” in the Export tab of the Auro-Mixing Engine.


3.9.1.1	 Monitoring

The “Monitoring” Output let users listen to the selected monitoring configuration. The Monitoring 
Configuration Drop Down Menu is accessible from the Controls tab in the Auro-Mixing Engine


3.9.1.2	 Bed Mix

The “Bed Mix” Output filters objects and only outputs audio content from the bed. 


3.9.1.3	 Object Mix

The “Object Mix” Output filters content from the bed and only outputs audio objects.
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Figure 3 - 68 | Output Drop Down Menu in Auro-Return Plugin





 

3.10	 AuroMax Setup Guides 
 
These additional guides provide steps to follow in order to use AuroMax configurations. Please refer to 
the AuroMax Specifications for more details on these speaker configurations. → www.AURO-3D.com

3.10.1	AuroMax 20.1

 
To work with the AuroMax 20.1 configuration, the Speaker Configuration Drop Down Menu in the Auro-
Settings menu bar application must be set to “AuroMax 20.1”. 

In Pro Tools, the Output tab in the I/O Setup window must contain three output paths that are correctly 
assigned to the corresponding outputs of the audio interface (Pro Tools > Setup > I/O…):


• AuroMax 1-8: 7.1 Format.


• AuroMax 9-16: 7.1 Format.


• AuroMax 17-24: 5.0 Format. 

New Virtual buses must be mapped to these output paths in the Bus tab. These virtual buses must share 
the same format. It is also recommended to use identical names to avoid potential confusion. 


The Mix Profile must be set to “Cinema AuroMax” In the Settings tab of the Auro-Mixing Engine. One 
desired Bed configuration must be selected as well. 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Figure 3 - 69 | AuroMax 20.1 in the Speaker Configuration Drop Down Menu

Figure 3 - 70 | AuroMax 20.1 in I/O Setup

https://www.auro-3d.com/




 

 

In the Controls tab of the Auro-Mixing engine, the Monitoring Configuration Drop Down Menu must be set 
to “AuroMax 20.1”.


In the Edit window of Pro Tools, three auxiliary input tracks must be created following the same format 
than the output paths. After routing each track appropriately, It is recommended to rename the tracks 
according to their respective output path.

An Auro-Return plugin must be inserted on each track. It is recommended to rename the Auro-Return 
plugins according to their respective track names using the Name fields. The Output Drop Down Menu of 
each Auro-Return plugin must be set to “Monitoring”. The Preset Drop Down Menu must be set to the 
corresponding group of channels.
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Figure 3 - 71 | Cinema AuroMax Mix Profile using AuroMax 20.1

Figure 3 - 72 | AuroMax 20.1 Monitoring Configuration

Figure 3 - 73 | Auro-Return Tracks for AuroMax 20.1 Configuration





 

z


 

 
If using HD or HDX Audio Systems, a DSP plug-in must be inserted on the first Insert slot of 
every track that contains an AURO-3D® plug-in.

Inserting a (multi)-mono DSP version of the Trim plug-in reduces the DSP-overhead to a 
minimum and leaves the audio unaffected if the initial settings remain unchanged.


3.10.2	AuroMax 22.1

 
To work with the AuroMax 22.1 configuration, the Speaker Configuration Drop Down Menu in the Auro-
Settings menu bar application must be set to “AuroMax 22.1”. 

In Pro Tools, the Output tab in the I/O Setup window must contain three output paths that are correctly 
assigned to the corresponding outputs of the audio interface (Pro Tools > Setup > I/O…):


• AuroMax 1-8: 7.1 Format.


• AuroMax 9-16: 7.1 Format.


• AuroMax 17-24: 7.0 Format. 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Figure 3 - 74 | Auro-Return Plugins for AuroMax 20.1 Configuration

Figure 3 - 75 | AuroMax 22.1 in the Speaker Configuration Drop Down Menu





 

New Virtual buses must be mapped to these output paths in the Bus tab. These virtual buses must share 
the same format. It is also recommended to use identical names to avoid potential confusion. 


The Mix Profile must be set to “Cinema AuroMax” In the Settings tab of the Auro-Mixing Engine. One 
desired Bed configuration must be selected as well.

 
 
 

In the Controls tab of the Auro-Mixing engine, the Monitoring Configuration Drop Down Menu must be set 
to “AuroMax 22.1”.
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Figure 3 - 76 | AuroMax 22.1 in I/O Setup

Figure 3 - 77 | Cinema AuroMax Mix Profile using AuroMax 22.1

Figure 3 - 78 | AuroMax 22.1 Monitoring Configuration





 

 
In the Edit window of Pro Tools, three auxiliary input tracks must be created following the same format 
than the output paths. After routing each track appropriately, It is recommended to rename the tracks 
according to their respective output path.

An Auro-Return plugin must be inserted on each track. It is recommended to rename the Auro-Return 
plugins according to their respective track names using the Name fields. The Output Drop Down Menu of 
each Auro-Return plugin must be set to “Monitoring”. The Preset Drop Down Menu must be set to the 
corresponding group of channels.

 


 
If using HD or HDX Audio Systems, a DSP plug-in must be inserted on the first Insert slot of 
every track that contains an AURO-3D® plug-in.


Inserting a (multi)-mono DSP version of the Trim plug-in reduces the DSP-overhead to a 
minimum and leaves the audio unaffected if the initial settings remain unchanged.
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Figure 3 - 79 | Auro-Return Tracks for AuroMax 22.1 Configuration

Figure 3 - 80 | Auro-Return Plugins for AuroMax 22.1 Configuration





 

 
3.10.3	AuroMax 26.1

To work with the AuroMax 26.1 configuration, the Speaker Configuration Drop Down Menu in the Auro-
Settings menu bar application must be set to “AuroMax 26.1”. 

In Pro Tools, the Output tab in the I/O Setup window must contain four output paths that are correctly 
assigned to the corresponding outputs of the audio interface (Pro Tools > Setup > I/O…):


• AuroMax 1-8: 7.1 Format.


• AuroMax 9-16: 7.1 Format.


• AuroMax 17-24: 7.0 Format.


• AuroMax 25-32: Quad Format. 

New Virtual buses must be mapped to these output paths in the Bus tab. These virtual buses must share 
the same format. It is also recommended to use identical names to avoid potential confusion. 


The Mix Profile must be set to “Cinema AuroMax” In the Settings tab of the Auro-Mixing Engine. One 
desired Bed configuration must be selected as well.
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Figure 3 - 81 | AuroMax 26.1 in the Speaker Configuration Drop Down Menu

Figure 3 - 82 | AuroMax 26.1 in I/O Setup





 

 
 

In the Controls tab of the Auro-Mixing engine, the Monitoring Configuration Drop Down Menu must be set 
to “AuroMax 26.1”.

In the Edit window of Pro Tools, four auxiliary input tracks must be created following the same format than 
the output paths. After routing each track appropriately, It is recommended to rename the tracks 
according to their respective output path.
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Figure 3 - 83 | Cinema AuroMax Mix Profile using AuroMax 26.1

Figure 3 - 84 | AuroMax 26.1 Monitoring Configuration

Figure 3 - 85 | Auro-Return Tracks for AuroMax 26.1 Configuration





 

 
An Auro-Return plugin must be inserted on each track. It is recommended to rename the Auro-Return 
plugins according to their respective track names using the Name fields. The Output Drop Down Menu of 
each Auro-Return plugin must be set to “Monitoring”. The Preset Drop Down Menu must be set to the 
corresponding group of channels.

 


 
If using HD or HDX Audio Systems, a DSP plug-in must be inserted on the first Insert slot of 
every track that contains an AURO-3D® plug-in.

Inserting a (multi)-mono DSP version of the Trim plug-in reduces the DSP-overhead to a 
minimum and leaves the audio unaffected if the initial settings remain unchanged. 
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Figure 3 - 86 | Auro-Return Plugins for AuroMax 26.1 Configuration
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